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Videstra Release Note Documentation 
Videstra Release Notes are part of a progressive document designed to allow the reader to see all 
released versions since V14 of both the VestraView Client, V-Manager Server software as well as the V-
Streamer firmware since V30.  Each release is in its own section – simply scroll to the version from which 
you are updating and every update above that point will be part of the version you are installing. 
 
Version numbers in these release notes typically refer to the “Revision” of a Major.Minor release 
numbering schema.  Videstra numbers its releases as: 
 

MAJOR.MINOR.VERSION 
 

Releases that do not update either Major or Minor will usually be compatible with each other (e.g. 
Version 1.0.34 Client can be used with Version 1.0.12 server (V-Manager) and visa-versa).  If either the 
Major or Minor number(s) are different then the versions will be incompatible.  The client has an 
automatic way to disallow connecting to an incompatible server. 
 
Compatibility between the V-Streamer and the V-Manager is less clear, and Videstra Support should be 
consulted about any compatibility issues between the version of server (V-Manager) and the V-
Streamer.  It is recommended you always update to the latest version of the V-Streamer whenever 
updating the V-Manager and VestraView client. 
 
Missing Version Numbers 
Version 2.0.24, 25, 26, 27, 28… 
You will undoubtedly notice that version numbers are sometimes skipped.  These are almost always 
beta versions of software that needed to be updated.  To smoothly update our beta customers, we must 
always increment our version numbers – even when that means fully released version number get 
skipped.  It will be normal to update from Version 1.0.19 to Version 1.0.21 when no version 1.0.20 was 
ever made publicly available. 
 
Videstra takes great care to make this document as accurate as possible, however some fixes and 
updates may not be reflected in this document for various reasons.  Please forgive any omissions.  We 
do not, however, accept any liability for errors or omissions within this document and your continued 
use of the Videstra VestraView and V-Streamer product(s) indicates your agreement with this policy. 
 
 

Release notes are Copyright ©2016-2024 Videstra LLC 
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Videstra VestraView Client & V-Manager Server Release Notes 
 

All Releases After 2.3.05 

Microsoft DOTNET Framework Update May be Required 
Beginning with Videstra Version 2.3.10 the Microsoft DotNet Framework 
will be updated from 4.6.1 to 4.8.  Version 4.6.1 support ended on April 26th, 
2022, for all general Windows releases.   The update to the DotNet 
framework Version 4.8 will require a reboot post installation and may take 
up to 20 minutes if other Windows updates are in queue.  If you have 
previously updated to 2.3.10 (or installed any other software requiring 
DotNet Framework 4.8) than this does not affect you. 

CPU Usage Increase 
This release now incorporates some new capabilities that may require more CPU and I/O 
capability than some earlier versions of our V-Manager can support.  This has mostly to do with 
the Web Publishing of more than one (maybe two) timelapse movies to your web site.   If you 
wish to publish multiple timelapse videos from cameras to your web site please contact us about 
options to upgrade your V-Manager to a new rackmount solution with additional CPU and I/O 
capabilities. 

New Logos and Icons 
This release includes many fixes and many important enhancements, and it introduces a new 
look to the icons and Videstra Logo. 
 
 This is the new V-Manager logo you will find on the V-Manager desktop. 
 
 
This is the new VestraView logo for the VestraView client.  This is also installed on the 
V-Manager and will appear now on any workstation where you update/install the 
latest version of the VestraView client. 
 
The IP Discovery tool for V-Streamers also has a new desktop icon. 
 

 
Our new logo: 
 

 
 
…and our new abbreviated logo: 

 
Both come in black or white versions.  
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VestraView Client/Server | Version 2.3.17 

 

New Features/Fixes and Changes 
• Enforced Overlays would sometimes not change when a new camera was assigned to a V-

Streamer channel. This resulted in an incorrect overlay being displayed on the V-Streamer 
output channel. This issue has been fixed. 

• There is a new option to disable overlays for each V-Streamer channel independently. 

 
Under File → Settings → V-Streamer on the V-Manager Server Application there are a series of 
new checkboxes adjacent to each channel.  If checked then no overlays will ever appear on the 
channel. This includes both dynamic and enforced overlays. 

• Some Axis cameras with wiper controls were not compatible with the new Axis Clear View API. 
Older Axis cameras with wipers supported a standard method for activating the wiper. This 
release addresses this and is compatible with Axis camera wipers for old and new methods as 
well as the Axis Speed Dry function. 

• Overlay files (PNG) are now validated before they can become visible on the output of the V-
Streamer.  Invalid PNG files will simply be ignored. 

• Flex panel web controls would only open if users set a username/password reminder in the Web 
Control panel of the panel.  This update still allows you to set a username/password reminder 
and will still show the web control whether it is set or not. 

• For VestraView clients installed on subnets that are not the same as the V-Manager, but for 
which IT has created appropriate routing – the system now references the IP Address of the V-
Manager when calling for images for creation of time lapse movies.  This is done in case the local 
DNS has not been updated to provide the address of the V-Managers DNS name.  

• When using legacy Streamprofiles with Axis™ cameras Videstra was sending the incorrect API 
Parameter to specify the profile.  This resulted in the camera using the default stream 
parameters instead of the ones specified in the stream profile.  Videstra now sends the correct 
API command. 

• Several other bugs/fixes have been applied to this update. 
  



 
 

3 | P a g e  
 

VestraView Client/Server | Version 2.3.15 

 

New Features/Fixes and Changes 
• The Production Automation interface (previously called the N7k Automation Interface) has been 

completely rewritten to properly accommodate both Ross OverDrive™ and GVG Ignite™.  A 
Separate document for the Videstra Automation Interface is available here: 
https://www.videstra.com/manuals/Videstra_Production_Automation_Documentation.pdf 
Some of the changes include: 

o Full emulation of the Evertz Quartz™ protocol – Videstra is seen by the automation 
system as a Quartz router. 

o Videstra supports both fixed sources as well as Virtual Sources. A Virtual Source is a 
combination of a PTZ camera and a preset. 

o Removal of all references to N7k (which stood for the Native 7000 router protocol the 
automation system previously used). The system uses the term Automation or 
Production Automation now. 

• Web Publishing with Videstra now offers an option to use either OpenWeather.org™ or The 
Weather Company’s™ REST API to apply current weather conditions to images, timelapse 
movies, and live streams for your web site(s).  The basic level of OpenWeather continues to be 
free, however The Weather Company charges for use of their REST API.  Many stations that use 
The Weather Company graphics system for on-air weather presentations may find they already 
have full access to this API (typically from their groups corporate subscription) and thus this may 
be an option. 

o The V-Manager Settings tab previously labeled as OpenWeather is now simply labeled 
as Weather API. 

 
o As with OpenWeather you will need an API Key to use The Weather Company API.  You 

do not need keys for both, just one. 

• The zoom feature with Axis cameras has been improved to eliminate pausing and lagging.  It will 
operate much more smoothly now. 

• The Videstra native Axis PTZ control now fully supports the wiper blade on Axis models Q8615-E 
and the Q6225-LE cameras. While still fully supporting Speed Dry™ on Axis dome cameras, the 
8615 and 6225 have wipers that can be remotely actuated.  When controlling one of these 
cameras with the Videstra PTZ control there is a new button simply labeled “Wiper” that will 
activate the wiper for 10 seconds. 

• The YouTube Library used on the V-Manager can now be updated by a system manager. There is 
a new YouTube tab in the V-Manager Settings dialog called YouTube.  On this tab a system 
manager can disable YouTube entirely, or update the libraries used to manage YouTube Live 
Streams.  Once disabled, YouTube streams can be re-enabled on this same tab, however each 
individual YouTube tab will also need to be re-enabled under Panel Settings (on each panel). 

https://www.videstra.com/manuals/Videstra_Production_Automation_Documentation.pdf
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• Some Sony™ cameras presets were not accessible due to a parsing difference within the Sony 
line.  This has been adjusted to allow all supported Sony camera presets to work as expected. 

• For stations that have Videstra LiveShare™ (Live streaming of your Micro-Local cameras to your 
web site(s)) the setting for the LiveShare URL has been moved from each individual camera to a 
global setting under V-Manager Settings. 
 

 
  



 
 

5 | P a g e  
 

VestraView Client/Server | Version 2.3.14 

 

New Features 
• The VestraView client now has its own Internet Explorer compatible browser that supports 

ActiveX controls.  Many older cameras require the installation of ActiveX controls in order to 
access the camera PTZ capabilities.  The new Videstra Active X (VAX) Browser is available only 
when using the Videstra Flex Panel™ and can be set as the default Web Control for any Flex 
Panel managed camera. 

 
 
Note: This browser has limited functionality and can only be used inside of the Videstra Client.   
 

• Other enhancements to the Flex Panel include the ability to show a username/password hint, to 
directly embed the username/password in the http url (this will only work in rare instances). 

 

• Passwords for cameras can now contain special characters.  We still recommend only using 
upper and lower case letters and numbers. Some cameras will not accept usernames and 
passwords when they are presented as part of the camera URL (this functionality has been 
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deprecated for HTTP, but not for RTSP). While some characters may work, there are some 

characters that must be avoided.  These include the following: @ / \ ? < > % + = * 
• Logging for all errors in the V-Manager is now managed to keep the file from growing too large. 

• The Automatic Timelapse Scheduler now supports Sunrise and Sunset settings. 

• The YouTube™ functionality has been enhanced to allow in-place upgrades if/when YouTube 
changes their protocols.   

o Note: Videstra will maintain this functionality only if it remains economically feasible to 
do so. 

• Release notes can now be accessed from the VestraView client Help menu 

• If a Bolin camera has been deployed to use port forwarding the compass will not work. There is 
a new ability to hide this compass when this becomes necessary. 

• Nightly backups that are currently made to videstra.net may also be copied to a local share if 
desired. 

 
 

Fixes & Changes 
• When setting the RTSP Path in a Flex Panel the path would become truncated if any forward 

slashes were used.  This has been fixed. 

• Some potential infinite loops were discovered and fixed. 

• Bolin cameras were inadvertently set to automatic gain when using the PTZ control.  All Bolin 
cameras should be set to “custom” – and this setting is now maintained properly. 

• When applying overlays to the V-Streamer output the V-Manager will now do a “safe copy” to 
the V-Streamer of any new overlay files. This prevents possible errors that could potentially 
cause the V-Streamer to show the incorrect overlay for a camera. 

• Fewer “zombie” icons for the V-Manager should ever be in the System Tray – an attempt to 
clean these up is now made on each restart of the V-Manager 

• The Ambry only IP Power Control interface has been replaced with the more generic capability 
to open a web URL to any IP Power Controller.  This gives customers more options for IP 
Controlled power strips from companies other than Ambry’s IP-P2 unit.  The new generic option 
is fully compatible with the Ambry unit. 
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VestraView Client/Server | Version 2.3.13 
 

New Features 
• Initial release of an all-new capability to use YouTube™ Live Streams in the Videstra system. This 

requires updating your V-Streamer to Version 4.00.7 (See V-Streamer Release Notes at the end 
of this document 
This exciting new feature gives you access to hundreds of YouTube Live Streams from cameras 
and feeds from a wide variety of sources. 
Only live streams from YouTube are supported and use of any live streams should take 
copyrights into proper consideration.  See our YouTube statement at the end of this document. 
 

 

 
 

• Access to IP Controlled power strips deployed at remote camera locations is now available for 
every Axis, Bolin, Sony, and Truen camera through the IP Power strips native web page.  This is 
set up inside each panel.  Access to this is only from the V-Manager.  This is no longer only 
focused on the Ambry IP-P2 Model IP controlled power strip – but now simply allows connection 
to any IP Controlled power strip via the units native HTTP web presentation (if supported). 

• Orphan SourceMonitor logs (for panels that no longer are in use) are now automatically deleted. 

• The Graphics Template editor now pulls a clean image from the server as an example for 
placement of various elements on the canvas.  This eliminates overlays that may confuse 
anyone designing a template for web publishing 

• The Restart on Crash (ROC) application is automatically started, configured, and stopped with 
the V-Manager application. 

• When available device serial numbers and model numbers are now saved to the main system 
setup file for persistence.  This allows you the possibility of getting a serial number from an 
inaccessible camera/device. 
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• A compass has been added to the Bolin 
PTZ control.  Once calibrated this compass 
allows you to confirm the ordinal 
direction of the camera 
 

 
 
 
 
 
 
The new compass on the Bolin PTZ does 
not update until you stop panning the camera – this is necessary to make sure the camera stops 
as soon as it can when you release the mouse button while moving the camera 
An option to hide the compass is available in the Permissions tab of the camera setup dialog. 
This is useful if you have no intention to use it (declutters the UI) – or if poor connection issues 
prevent certain ONVIF protocols required for Bolin directional information. 

• Added additional image capture methods to the Videstra Flex Panel™ for Lorex™ and HikVision™ 
cameras 

• Post Process Script capability has been removed from the Timelapse Factory™ due to disuse 

• The Timelapse Scheduler now can simply specify 
Sunrise or Sunset rather than only specific times 

 

 
• Passwords for any panel (cameras) will no longer let 

you enter characters that are reserved for use in a URL or URI.  This is because rtsp feeds must 
embed the passwords within the URL and any special characters encountered will confuse the 
URL parser.  This means you are limited to upper/lowercase letters, numbers 0-9, the tilde ~, 
underscore _, and the dash - 
 

 

Fixes & Changes 
• Fixed a software crash if a non-existent graphics template was requested while editing Web 

Publishing settings 

• Bolin cameras are now compatible with HTR Timelapse Capture (Images captured as often as 
every 10 seconds) 

• Under certain circumstances weather data was being passed to the Graphics Templates 
incorrectly 

• Nightly backup of critical files to videstra.net was failing if the VxFTP2 was not installed 

• Nightly backup now properly backs up to either videstra.net or a local share (or both) 

• Stray V-Manager and Restart on Crash (ROC) icons in the system tray are now cleared out with 
each startup and shutdown of the V-Manager 

• Added network settings to a text file in the backup to videstra.net 
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VestraView Client/Server | Version 2.3.12 
 
 

New Features 
• Only one person at a time can now edit Timelapse Schedules.  If someone is editing and another 

person tries then they will not be allowed until the other person is finished.  This prevents 
collisions that can cause loss of any newly added items. 

 

Fixes & Changes 
• Previewing the Graphics Template in Web Publishing will no longer crash if the 

OpenWeather.org Key has not been set. 

• A new TAG field has been added to the Live to Web setup that is a fixed reference to a camera 
source. This fixed reference should never be changed without help from Videstra support. 

• The process that monitors cameras when they go offline (called SourceMonitor) was not 
properly addressing Bolin cameras.  This has been fixed. 

• Stability and consistency improvements 
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VestraView Client/Server | Version 2.3.11 
 

New Features 
 
New Animated Timelapse Clock 
When publishing timelapse movies from any camera to a website, a new Timelapse Clock overlay can be 
included to help the viewer to visualize the timespan covered by the timelapse. 
 

 
 
During playback of the timelapse movie the clock hands will animate from the start-time of the 
timelapse to the end.   
The clockface on the timelapse can be customized.  The hour and minute hand color can be selected, 
and several optional faces are provided. Also, an Adobe Photoshop™ PSD file is provided so that you 
may modify as desired.  Documentation for modification of this new Timelapse Clock is available here: 
https://www.videstra.com/manuals/Timelapse_Clock_Customization.pdf 
 
Live-to-Web Branding 
Videstra offers the ability to publish cameras on your web site live.  There is an additional cost to this, 
however it is priced very competitively and offers you full station branding without imposing any of our 
own branding requirements.   Version 2.3.11 of the Videstra system lets you design the branding overlay 
that will appear on the live feed for each camera (all can be the same or different) – including 
automatically updating current weather conditions for the camera location.  For information and pricing 
on the Videstra Live to Web™ capabilities please contact Videstra support. 
 
Image Capture in Timelapse Factory™ 
The Videstra Timelapse Factory™ now lets you save a full resolution image by right clicking on the 
preview image and selecting Save Image.  Previously this function only saved a very low-resolution 
image. 
 
Camera Control Permissions (Axis & Bolin Cameras) 

https://www.videstra.com/manuals/Timelapse_Clock_Customization.pdf
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A new feature to allow password protection of the camera settings functionality in Axis and Bolin 
cameras has been created.  In Camera Settings (Bolin and Axis cameras only) there is a new 
“Permissions” tab where you can set passwords to restrict some users from using certain camera 
controls that includes any PTZ functionality, any camera exposure controls, or changing/creating 
presets. 
 

 
 
Floating your mouse over the little i icon will tell you more about these new features. 
 

 
New Axis Focusing Method 
The Axis PTZ control has been simplified a bit by removing the Focus/Zoom switch (which was mostly 
confusing).  Manual focusing for the Axis cameras can now be done using the shift-key in combination 
with the mouse wheel.  This is only necessary when using very long focal lengths (zoomed in a lot).  
Manually adjusting focus will temporarily override autofocus. 
 
Timelapse Scheduler Extended 
The Timelapse Scheduler previously only allowed a timelapse to cover up to the previous 5 hours.  This 
has been extended to 15 hours. 
 

Fixes & Changes 
• The Timelapse Scheduler can now be opened only on one workstation at a time. If anyone has it 

open and a second person tries to open the editor on another workstation they will be denied 
access until the first person has saved their work. 

• SourceMonitor, a program that runs in the background on your V-Manager, is designed to 
reconnect cameras when they temporarily go offline. It has been updated to reconnect Bolin 
cameras.  Bolin cameras will now automatically reconnect when they go offline after 
SourceMonitor determines they are available again. 

• The minimum interval for Web Publishing Timelapse movies has been changed to once every 10 
minutes.  This has been done to reduce CPU load on the server. 
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• VxFTP² minimize icon used to be a red X.  This was confusing because an X looks like it would 
stop the application. The new icon now makes it clear that you are only minimizing the 
application. 

• You can now properly exit the DOT Selector with Alt-F4. The DOT Selector also will now show 
scroll bars if opened on a monitor with insufficient resolution to display the entire User 
Interface.  

o Note: The minimum recommended interface for the VestraView client is 1280x720 

• A new compass style has been provided for the Axis PTZ control.  Also, the compass shown on 
the PTZ control would, on some rare occasions just disappear. This has been fixed. 

• When entering the Weather Graphics shares, Videstra now properly applies the leading “\\” 
characters.  
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VestraView Client/Server | Version 2.3.10 
 

New Features 
 
Bolin Native Control 
 
Videstra now natively supports the Bolin SD520 camera with a dedicated PTZ control (like the 

way Videstra supports Axis, Sony, and Truen cameras).   This new PTZ 
control greatly simplifies how users interact with the camera and gives full 
PTZ (Pan/Tilt/Zoom) functionality, access to use and manage presets, 
enable, and disable certain features and basic exposure control.  
 
 
 
 
 
 

 
The New Bolin PTZ Control Interface 
 

 
The New Bolin PTZ Control 

 
Panning and tilting the Bolin Camera 
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The new Bolin PTZ control has two concentric circles – clicking anywhere inside the smaller 
circle will start to pan or tilt the camera (in 45° increments) slowly.  Clicking inside the larger 
circle starts the pan or tilt at a higher speed.   

 
 
 
 
 
Generally, the further from the 
center, the faster the movement of 
the camera.  Releasing the mouse 
stops the movement. 
 
 
 
 
 
 
 

 
 
 
Zooming 
Zooming can be done with the mouse wheel – forward zooms in, backward zooms out. 
 
Focusing 
When zoomed tight small focus correction may be accomplished by holding the shift-key and 
using the mouse wheel to adjust focus. 
 
Other Bolin Features 
From within the new Bolin PTZ control you can manage the presets (use, create, delete, 
update), turn image stabilization on/off, activate a fog filter (simply increases overall contrast, 
turn HDR on/off, change white balance, adjust exposure, and activate the wiper. 
 
Bolin Setup Guide 
We have authored a guide to properly setup and deploy the Bolin SD520.  You may access it 
from our website here:  
 
https://www.videstra.com/manuals/Installing_and_Optimizing_Bolin_SD520.pdf 
 

Fixes & Changes 
• When an overlay is used on a camera, then removed, by setting it to “none” it would 

come back the first time the camera was assigned to a V-Streamer channel.  This has 
been fixed. 

• A new preview window has been created for the DOT panel that will show previews of 
both DOT streams and images.  This is set to always use TCP because some DOT 
streams tend to smear when using UDP.   The new preview window is very simple with 
only a single Exit button. 

https://www.videstra.com/manuals/Installing_and_Optimizing_Bolin_SD520.pdf
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New Simple V-Player for Previewing Streams & Images 

 

• DOT URL display now updates before the URL request is made so it shows even if the 
URL is unavailable. 

• DOT Favorites capabilities are now managed differently.  Favorites can be added, 
deleted, or cleared. 

 
• You may also mark any single favorite as “default” and it will automatically load when 

the DOT Selector is opened. 

• Beginning with Version 2.3.8 we are now enforcing the 60-day limit on use of the 
default BING key.  The 60-day counter will begin with this update.   If this expires you 
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will no longer be able to use the DOT Selector.  Contact Videstra support and we will 
guide you through the process of obtaining your own free Bing Maps API key. 

• When using overlays with any camera the action of removing the overlay sometimes 
would fail.  This has been fixed. 

• Right-clicking on any IP Address in the VestraView applications (VestraView Client or V-
Manager) will let you copy the IP Address to paste anywhere else.   If an IP Address is 
found in the clipboard you may also paste it into the IP Address control. 
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VestraView Client/Server | Version 2.3.05 
 

Note: This release includes many fixes and many important enhancements, however it will 
not alter any existing workflows so users who might be unaware of this update will 
not be adversely affected! 

 

New Features 
 
New Web Publishing Documentation 
There is a new document on publishing your Micro Local Cameras to your web site(s).   This 
document outlines the many capabilities of the Videstra web publishing tools, and it is available 
via this link: https://www.videstra.com/manuals/Videstra-Publishing_to_the_Web.pdf 
 
Script Free Publishing 
Web Publishing has been enhanced significantly.  All web publishing is now done “script free” – 
meaning complex command scripts are no longer required for creating content, managing 
uploads, and automatically updating to your web site(s). 
 
Weather Information on Published Images & Movies 
Current, localized weather information may now be added to images and timelapse movies 
that are published to the web.   

 
Based on data from OpenWeather.org™ each camera location is queried so hyper-local 
conditions (temp, sky, wind, wind direction, feels-like, humidity, precipitation type, 
precipitation amount) as well as a descriptive icon can be placed on published images and 
timelapse movies. 
 Note: Camera Geo Location (Lat/Lon) must be set in a new Location tab in Panel 

Setup for automatic retrieval of weather data for any camera location. 
A default current conditions icon set is provided (with an alternative): 

https://www.videstra.com/manuals/Videstra-Publishing_to_the_Web.pdf
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You may create and easily install your own icons.  Icons may be displayed as small, medium, 
large, or huge. An Adobe Photoshop™ PSD file is also provided with layers of all icons. 
 
Timelapse Publishing to the Web 
Timelapse Publishing is now possible as either web based WEBM Movies or animated GIF files.  
Timelapse movies can cover the previous 10 to 180 minutes. 
Timelapse movies can be updated as often as once per minute (5-minute interval is 
recommended) or once per hour.  All timelapse movies will cover the selected period to the 
time they are created/published.  Timelapse movies support the same graphics overlays 
(including weather info) as still images. Timelapse movies employ cross-frame blending for a 
more fluid and pleasing presentation. 

Note: WEBM Movies are a royalty-free movie format supported on current 
Chrome, Firefox, Opera, Safari and Android browser.  Web servers do not need 
special configuration for WEBM movies nor is any player required. WEBM 
movies are simply files placed on a page with HTML5 video tags.  

Animated GIF files are supported but be aware that GIF files (especially if frame blending is 
used) will be very large.  People visiting your web site with limited bandwidth may experience 
significant delays when viewing a very large GIF file. 
 
Automatic Timelapse Scheduling for On-Air Production 
Timelapse movies for your Weather Graphics System(s) can now be created automatically via a 
new Timelapse Scheduler.  

 
Scheduled Timelapse movies can be set to cover from the previous 30 minutes to the previous 
5 hours.  All scheduled timelapse movies cover the period up to the time they are created.   
The run-time for the movie can be set from 10 to 30 seconds.    
Each Videstra Panel can support many scheduled timelapse event. 
Movies can be automatically sent to your Weather Graphics system (e.g. The Weather 
Company (IBM) Max), to a writable share on your network, or to a local drive. 
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V-Manager Selection (Multi Login Option) 
For sites with more than one Videstra system the clients now support the ability for the user to 
select a V-Manager to which they would like to connect.  Each site must be defined in the client 
setup dialog by navigating to Configuration →Configure Client and click on ‘Set Alternate 
Connection’ 

 
Once any alternate connections are defined users will be asked to which V-
Manager they wish to connect.   Up to three alternate V-Managers may be defined. 
 
Camera Information 
New camera information has been added to the panel – This is informational only and will be used in a 
future feature to print a camera dossier for the Videstra system 

 
 
VxFTP is Replaced with VxFTP2  
A new version of the software used to upload images and movies to the web has been created 
that will use far less memory and resources.   
 

   
  Old Icon  New Icon 

 
FTP Profiles are still created the same way, however the new VxFTP2 loads into memory only 
once and does all uploads.  Previously, VxFTP would load into memory for each item being 
uploaded. 
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Fixes & Changes 

Client 

• Web publishing of images are now “script free” – meaning complex command scripts are no 
longer required for managing uploads and updates of camera images to your web site(s). 

• When including thumbnails with uploaded images/timelapse movies a suffix is now required. 
The default suffix appended to the image name is “_thmb” 

• Client now checks to make sure it has read/write access to the Windows registry at 
HKCU\SOFTWARE\Videstra\VestraView.  If access is not permitted you will get a startup 
warning.  Call Videstra for instructions on how to change this.  You may have to work with your 
IT Staff. 

Server 

• A new Server Nickname field has been added to the V-Manager Settings General page.  This is to 
identify the server when the Muli-Login option is enabled at a site. 

• Images from Axis, Sony, Truen and Bolin cameras are now acquired through a new, speedier and 
resource conservative library.  This adds both reliability and speed that benefits the High 
Temporal Resolution timelapse capability in VestraView 

• When connecting to an Axis camera the query for a list of available resolutions was not formed 
properly – causing an unnecessary delay 

• Images from Axis cameras are now retrieved more swiftly through a streamlines process 

• The IP Discovery tool was missing a library file causing it to fail 

• Previously a 3rd party log viewer called BearTail™ was used to view all logs created by Videstra. 
This has been replaced by a new open-source log viewer called SnakeTail.  SnakeTail has no 
splash screen and allows searching as well as text copy functionality unavailable in BearTail. 

• When entering required API keys for Bing Maps and now the new OpenWeather.org (both free 
by the way) there is a quick way to test that your key is valid (in case you entered it incorrectly). 

• When changing traffic cameras on a DOT panel all images from the previous camera are deleted 
from the timelapse cache.  This avoids the possibility that a scheduled timelapse will use images 
from the wrong camera. 

• Under the Maintenance menu the option to reset your V-Streamer(s) has been changed to read:  
“Soft/Safe Reset V-Streamer(s) to reflect that this is a very safe way to reset all four channels on 
your V-Streamer (or all 8 if you have two V-Streamers) 
when you think a channel is locked up. The reset process 
only takes about 6 seconds and the stream currently 
assigned to the channel is then re-acquired (which may 
take additional time). 
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VestraView Client/Server | Version 2.2.24 
 

Note: This release includes many fixes and a few important enhancements, however it will 
not alter any existing workflows so users who might be unaware of this update will 
not be adversely affected! 

 

Client 
• DOT Panels now may only be named by the system automatically.  They will be named DOT 

Panel 1, DOT Panel 2, DOT Panel 3, etc.  There is a new field above the panel name that shows 
the DOT Camera Name. 

 
In TileView mode the DOT Camera name is used instead of the panel name due to limitations of 
available space on each time. The DOT camera name provides better information for anyone 
looking at the available sources when in TileView mode.  
There is also a new indicator that appears directly after the camera name to indicate if the 
source is a still image or streaming video.  A video camera icon for streaming video and a still 
camera icon for still images will indicate if the source is a stream or still image. 
The name change was made to better accommodate the N7k Automation capabilities allowing 
automation of the Videstra system through products like Ross OverDrive™ and Grass Valley 
Ignite™ 
Within OverDrive and Ignite the source of any DOT panel will indicate DOT Panel 1, or DOT Panel 
2, etc.  Selection of that panel through Overdrive or Ignite will show the camera currently 
selected on that panel.   
A new warning will now appear on a panel when the source of a DOT panel (a new DOT camera) 
is selected.  
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The warning will only appear if one or more V-Streamer channels are assigned. This new feature 
is designed to remind users that they must reassign the source to the V-Streamer (simply by 
clicking on the button again) since the previous assignment remains in the V-Streamer channel. 

• In the DOT Selector, selecting the checkbox to ‘Show URLS for Video Sources Only’ (as opposed 
to still images some DOTs provide) the map will now update all pushpins. 

• The DOT Selector would go into a semi-transparent mode when dragging it to a new position on 
the monitor. This feature was removed as it appeared more like a bug than a feature. 

• Several fixes were made to TouchScreen mode.   
o In TileView the touchscreen mode would not always scroll when using your finger to 

drag the available tiles up and down.  This has been fixed. 
o In TileView mode scrolling the tiles would also activate the tile from which you were 

scrolling.  Now scrolling will only scroll, and a single touch and release will activate the 
selected source. 

o The touch sensitive area of each tile has been made more consistent. Previously there 
was a blank area of each tile that was not touch sensitive. 

o In TileView mode sometimes it was not possible to select a source if it was down near 
the bottom.  This has been fixed. 

• The tooltip that shows the age of each image when you float the mouse over the thumbnail of a 
panel no longer shows if you enlarge the image with a right-click. 

• A new method for capturing images from a Dahua™ camera has been added to the Flex Panel. 

• Several efficiencies have been added to the native Truen™ camera control (AKA Lamar™ 
Cameras) 

• Several stabilization fixes to address memory usage and CPU loading. 
 

 

Server (V-Manager) 
• There is a new Disable Cache-Buster on the Settings→Traffic tab.  This is necessary for some 

states that only provide still images.  At the time of this release only Georgia requires this cache-
buster to be disabled. 

• The V-Manager will now make sure there are no stray running VxFTP processes that might be 
locking resources. 

• HLS Streams delivered via an HTTPS secure connection are now supported. 

• When setting a source to HTTPS the default port now switches to 443 (can be changed by the 
user if necessary) 

• For some HTTPS sources (both images and streams) the background monitor process would exit 
prematurely. 

• Backups to the Videstra.net cloud will now verify the main VestraView.XML file to make sure it is 
valid before performing any backup.  This is done to prevent overwriting valid backups with 
invalid ones. 

• Valid DOT Image types now include .jpg, .jpeg and .png. 

• Automatic TeamViewer updates can now be temporarily disabled.  This is only necessary if 
Videstra support is monitoring your system for longer than a single day and should not be 
enabled without consulting with Videstra support. 

• All shares used by the Videstra System for updating clients and copying images to VestraView 
clients for the Timelapse Factory™ and Clip Factory™ were previously administrative shares. 
Because many customers IT divisions routinely disallow the use of administrative shares we 
have changes ALL shares to standard shares.   This does not compromise security as all shares 
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are read-only, but they are no longer hidden from anyone listing available shares on the 
network. 

• Multi-threading enhancements and fixes. 
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•  

VestraView Client/Server | Version 2.2.18 

Client 
• The client will now sense when the V-Manager server has stopped responding (or has been 

purposely stopped).  If the server shutdown was not user initiated then the VestraView client 
will go into “stasis” mode and display “Disconnected: Waiting…” at the bottom of the User 
Interface.   Once the V-Manager server application becomes available the client will 
automatically restart. 

 
It will take about 15 seconds for the client to determine the V-Manger server is no longer 
available before it shows this message.  While the message is showing the entire client user 
interface is locked – except the ability to move, minimize or close the application. 

• Occasionally “Error” would appear on the Offline image when a panel was taken offline. This has 
been fixed. 

• Occasionally the “Error” message on an image that would appear on the V-Manager server 
would not appear on the client. It now appears on the client within a few seconds of appearing 
on the server. 

 

Sever (V-Manager) 
• The VMS Interface has been removed from the system and fully replaced by the N7k Router 

Interface for automation with Ross OverDrive and Grass Valley Ignite. 

• Corrected a missing dll (Application Dependency) for the N7k Automation Interface. 
• To enhance security a new process has been added to the V-Manger to update the TeamViewer 

to keep it up to date with the newest version.  This update will be checked and done at 2:30 
every morning. 

• When starting up the delay to display images has been reduced. 
• A potential deadlock while doing the nightly timelapse image cleanup has been eliminated. 
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VestraView Client/Server | Version 2.2.17 

Client 
• The VestraView DOT Camera Panel search functionality was not working in the previous release 

due to the introduction of the California Zone capability.  This has been fixed. 

• Adding the first panel to VestraView from the Panel Library would cause the client to crash. This 
has been fixed. 

 

Server (V-Manager) 
• The V-Manager will now automatically backup all critical configuration files to 

backups.videstra.net.  The backup occurs each time the V-Manager is started and once per night 
at around 2 AM.  This can be turned on or off in the V-Manager General Settings tab, but it is 
highly recommended you allow this backup to occur. It is turned ON by default. 
 

 
 
If you turn it off, please make sure you are doing regular backups of your Videstra system. In the 
rare case of a catastrophic failure of the V-Manager computer having access to the backup can 
make recovery much faster. 
Backups to videstra.net are secure and encrypted. They are only available from Videstra 
support. 

• Most changes now made to the settings in the V-Manager will now automatically require a 
restart of the V-Manager application (not the machine).  All currently logged on clients will be 
forced off immediately. 
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VestraView Client/Server | Version 2.2.15 

Client 
• The VestraView client will now retry up to 3 times when attempting a connection to the V-

Manager. 

• Boosted ethernet transactions by no longer waiting for a minimum number of bytes to send 
when issuing any network commands. 

 

Server (V-Manager) 
• The V-Manger panels for each source (Camera) no longer shows the Connection Count. This was 

always valid for Axis cameras only.  You can still get a connection count from the Gear Menu on 
a V-Manager panel servicing an Axis camera – but only if the logon credentials for the camera 
are administrative. 
Note: Videstra recommends all credentials for cameras be administrative. 

• Improvements on how asynchronous connections are made to Truen (Lamar) cameras have 
been made. 

• There is a new No Ping option in the V-Manager settings General Settings page.  This tells the V-
Manager to skip any attempts to ping sources. This was introduced to support sites that have 
had outgoing ICMP Ping capabilities disabled by their IT division. 

• There is more consistency now for any V-Manager settings changes that require a restart of the 
V-Manager application.  A restart of the V-Manager will automatically notify all connected 
VestraView clients. 
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VestraView Client/Server | Version 2.2.13 

Client 
• The Videstra system is now compatible with the California Department of Transportation 

(CALTRANS) cameras.  Unlike other DOT cameras, California maintains separate Zones for their 
cameras and Videstra allows you to filter cameras by zones now. 

• The DOT Interface will now let you use still images provided by the DOT in your V-Streamer. The 
V-Streamer will simply display it as a still-frame. 

• There is a new setting in the camera panel setup for Axis cameras to indicate if the user is 
administrative or not. This will be used to determine if the system will even try to get a 
connection count from the Axis camera as the connection count is only available to an admin 
user. 

 

Server (V-Manager) 
• Some Axis cameras report resolution using older nomenclature such as D1, 4CIF, 2CIF, rather 

than the current Width X Height all current Axis cameras use.  Videstra now automatically 
translates these to their NTSC equivalent.  Note that all such resolutions are well below modern 
HD standards and you should consider replacing these cameras as soon as possible. 

• Some startup issues that caused the V-Manager to crash have been fixed. 

• System was checking for DOT updates even if the DOT panels were not enabled.  This has been 
fixed. 
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VestraView Client/Server | Version 2.2.11 

Client 
• Both the Axis and Truen PTZ dialogs have been simplified. All manual exposure methods have 

been removed and the camera will be put in automatic exposure mode upon entry into the PTZ 
dialog.  Exposure compensation is still active and allows a sufficient degree of exposure control. 

• Axis PTZ dialog now correctly interprets the HDR setting for the camera. 

• Some functions available in the PTZ dialog require administrative privileges.  If a user attempts 
to use one of these a meaningful message is now presented, and the function is turned off.  

• The DOT Radar Overlay has been significantly improved. Previously panning and zooming 
triggered a new download of the radar images. The improved version now downloads the entire 
available North American radar imagery and allows full panning and zooming without needing to 
access new imagery. 

• DOT favorites will now be preserved during DOT database updates provided the camera name 
does not change. 

• Users can save multiple DOT Favorites and load them when desired. For example: Favorites for 
morning drive and afternoon drive can be saved separately. 

• DOT database checks for update nightly (midnight) and on-demand. 

• There is now a significant improvement in acquiring images when creating timelapse movies in 
the Videstra Timelapse Factory™. 

• Camera credentials for Axis cameras can now be marked as Admin credentials or not. If 
credentials are not administrative the V-Manager will no longer attempt to acquire a connection 
count (since that requires admin privileges). 

• Image capture quality settings for Truen cameras is now automatically inversed at the server.  
Truen cameras (Lamar) use a quality setting that is reversed from other cameras. 

 

Server (V-Manager) 
• The Videstra system now supports Automation from systems such as Ross Overdrive™ and GVG 

Ignite™ for production.  The Videstra system will emulate a Grass Valley 7000 Router host and 
accept Source, Destination and Level commands from any automation system that supports the 
GVG Native 7000 protocol.  Sources can be either physical or virtual. Physical sources are 
individual cameras being managed by Videstra; virtual sources are physical cameras with specific 
PTZ presets making it possible for a camera that supports presets to be any number of sources. 
Separate documentation for the all new Videstra N7k Automation Interface is available: 
https://www.videstra.com/manuals/Videstra_N7k_Documentation.pdf 
This new capability is available at no additional charge to Videstra customers who are current on 
service and support maintenance. 

• DOT Credentials have been moved from individual DOT panels to a single global setting. 

• DOT Interface now supports using DOT provided images for each camera when available.  This is 
only recommended when DOT streams are slow to acquire (such as North Carolina). 

• If DOT is not enabled the server will no longer check for updates 

• Capturing of HTR images is now a background task, and thus requires fewer resources 

• Capturing of HTR images now has additional error checking to keep it more independent from 
the main functions of the V-Manager server and allows for a longer timeout 

 

https://www.videstra.com/manuals/Videstra_N7k_Documentation.pdf
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VestraView Client/Server | Version 2.2.9 

Client 
• The Channel Manager that allows you to set any V-Streamer™ channel to Black or Test Pattern 

was not painting correctly when activated. 

 
 

• The Truen (Lamar™) interface has been enhanced to work with the newer cameras (Tested with 
TN-B236N15).  We have also updated the interface by removing unpopular elements and 
switched to supporting cameras only while in automatic exposure modes – while still retaining 
full exposure compensation capabilities. 

 
• We have also added diagonal pan/tilt functionality to the interface. 

• Some changes were made for cameras with low-bandwidth connections to prevent run-away 
panning/tilting/zoomin.  It is, unfortunately, still possible for this to occur as commands are 
stuffed into the TCP/IP queue faster than the camera can receive them – and TCP/IP just queues 
them up. 
 

Server 
• If you are using the DOT Camera interface the DOT Data Files (the ones that provide all the 

information on available cameras, locations, names, routes, etc.) are now provided through an 
automatic download from videstra.net.  Your Videstra system will check for DOT updates every 
night (~midnight), download and install any available updates.   
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• If you want, you can manually check for updates at any time by going to the V-Manager 
File→Settings option then the Traffic tab: 

 
Clicking on Update Camera Data will immediately check for and install any available updates. 
 

Note: Updates do not happen very often – do not expect update more 
often than once every few months. 

• Added additional error checking when acquiring HTR images. 

• Exiting the DOT Selector with ALT-F4 no longer generates an error. 

• Internal DOT Camera ID’s (not visible to the user) are now generated from the 
camera name and location. This preserves favorites when DOT data is updated 
provided the original name or location have not changed. 

• Setting the default Latitude and Longitude for the system was not working and 
would generate an error.  This has been fixed. 

• In Web Publishing all thumbnails generated by the system will be named the same 
as the main images when uploaded to the web server.  This name is either the 
panelname, or a name put into the Web Publishing options Scripts tab under 
Rename to. 

• Spaces in Profile names for VxFTP are now being handled properly.  While it is 
best to avoid using spaces in profile names – it is now OK. 

 

VestraView Client/Server | Version 2.2.6 

Client 
• The timeout waiting for images during timelapse creation has been extended to support the 

large number of images that can be used when a camera has been set for HTR (High Temporal 
Resolution) 

• A new reset option has been added to reset the V-Streamer. This is different from a reboot as it 
takes less time and will usually fix issues that can be caused by cameras/internet connections 
that send bad packets and lock up a channel. 

 
On both the VestraView Client and on the V-Manager this new reset option is available under 
the Maintenance menu option. 
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Note: These features require V-Streamer V4.02 and above. 

• If a camera has HTR (High Temporal Resolution) enabled a new HTR logo now shows in the 
Timelapse factory. 

• The IP Utility for locating V-Streamers now support more than two V-Streamers and has a new 
User Interface. 

• A new Radar Overlay has been added to the DOT Selector panel that allows the user to show 
current national radar (from University of Iowa Mesonet). 

 
 

Server 
• SourceMonitor now shells ffSourcemon.exe instead of ffmpeg.exe for monitoring sources 

• Sometimes Offline and Disabled status for a source(camera) was not properly reflected – this 
has been fixed 
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• Connection to the Weather Graphics system now requires setting the systems Username and 
Password to reliably place timelapse videos on the Wx Graphics system.  This setting can now be 
set in the V-Manager setting on the Wx Graphic System tab. 

 
 

• A new “helper” has been added for entering information for the Weather Graphics System.   

 
• When upgrading to this version from older Videstra systems that did not support HTR (High 

Temporal Resolution) existing image filenames are converted to the new HTR format 

• All DOT images are now captured from the available streams rather than from image files 
offered either directly from the DOT or 511 (a 3rd party vendor). This makes sure the image is up 
to date. 

• When publishing images to the web the thumbnails are now renamed the same as the main 
images as specified in the ScriptOne and ScriptTwo (with the thumbnail suffix added).  A new 
Thumbnails folder has been added to the ScriptOne and ScriptTwo folders on the V-Manager 
where thumbnails are renamed and from where they are uploaded. 

• When copying the camera URL to the clipboard (from the V-Manger camera panel) the 
username and password are hidden in the confirmation dialog box. 

• Some of the GEO Information routines were not working due to the specification of multiple 
JSON parsing libraries.  The application now uses the same library throughout. 
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VestraView Client/Server | Version 2.2.00 
 

Warning: This update will delete ALL current timelapse images on your system.  Timelapse 
image capture will start fresh after the installation. 

 

Client 
• The system now supports capturing timelapse images as often as every 15 seconds, 20 second 

or 30 seconds (in addition to the default of once per minute).  This is called HTR for High 
Temporal Resolution and it is selectable on a camera by camera basis. 

 

 
Timelapse & HTR Tab 

High Temporal Resolution will make for much smoother timelapse videos and allow timelapses 
to be made for shorter time-periods (such as a weather burst that lasts an hour or less). Cloud 
motion will be less choppy and more billowy. 
HTR is not turned on by default. You can enable it on a new tab (Timelapse & HTR) in the Setup 
Panel option for each panel.  Not all cameras/sources are suitable for HTR. A guide will let you 
know the optimal HTR setting (30, 20 or 15 second) for each camera based on historical 
performance. Generally, if it takes a long time to get images from a camera, HTR is not 
recommended. 

 
Note: Enabling HTR for a camera/source will use considerably more disk 
space on the V-Manager.  V-Managers are shipped with 120 GB SSD Drives. 
These can be replaced with larger drives. Please check with Videstra before 
swapping any drives on your V-Manager. V-Manager drives must be SSD 
drives! 

 

• Timelapse Movie outputs are now available for direct publishing to the web (h.264 mp4 movies) 

• Attempts to create anything other than an MPEG4 movie for output to a Weather Graphics 
system will result in a warning message. 

• Main client would not paint properly if started in TileView Mode when there were less than 3 
Panels. 

• Permanent SDI overlays on the V-Streamer are now working as expected. 

• If no overlay files were in the SDI Overlay folder on the V-Manager entering Panel Setup would 
result in a client error. 

• Cameras with PTZ dialogs (Axis, Sony, Truen) can now be password protected. 
 

http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
https://creativecommons.org/licenses/by/3.0/
https://creativecommons.org/licenses/by/3.0/
http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
https://creativecommons.org/licenses/by/3.0/
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Several PTZ Dialog options can now be found on the Panel Settings → Basic Info Tab.   
Passwords are saved in the VestraView.xml file, however they are encrypted. 

• Removed an unnecessary warning about Stabilization that appeared even if stabilization was not 
selected when making timelapse movies. 

• Other fixes and enhancements 
 

Server 
• Only changes made to support HTR and some small bug fixes.  
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VestraView Client/Server | Version 2.1.2 
 

Note: Upgrading to any release after 2.0.30 includes major changes to publishing 
images to the web. If your system is currently publishing images to the web, 
Videstra will need to help you rework how it is being done to accommodate the 
new capabilities.  No release AFTER 2.0.30 is COMPATIBLE with any previous 
publishing methods! 

 

Client 
• The client now supports an all new TileView mode (in addition to the classic Linear View mode).  

 

 
New TileView Mode in VestraView 2.1! 

 
This new view mode lets you see all the cameras/sources with less scrolling.  You can click on 
any thumbnail to reveal to full control panel on the bottom of the User Interface where you can 
access the V-Streamer buttons, overlays, PTZ and other menu items. The last selected tile will be 
highlighted. 
Adding, deleting, moving and other configuration options must still be done from the classic 
Linear View mode.  Switching to the new TileView mode can be done either from the View 
menu:  
 

 
You may also click on the new (waffle) icon in the upper right-hand corner of the title bar. 

 

http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
https://creativecommons.org/licenses/by/3.0/
https://creativecommons.org/licenses/by/3.0/
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The icon will change to signify the ability to return to the classic Linear View when the 
application is in TileView mode. 

 
 
If your workflow benefits from the new TileView mode you can set the client to always start in 
that mode under the Configuration →  Configure Client menu. 
 

 
You may also specify how many 
columns you want the TileView mode 
to display. You may select from 3 to 7 
(while you may select 8 – that will 
require a monitor capable of 
displaying more than 1920 pixels 
wide). 
The following chart helps determine 
the optimal setting 

Resolution Max Tile Width 

2560x1440 8 

1920x1080 7 

1360x768 6 

1280x720 5 

While wider selections than 
recommended are allowed – you will 
see a warning note. 
 
 

The new TileView Mode also supports TouchScreen Mode. 
 

• When entering TileView mode the application will automatically center on-screen if the wider 
view TileMode presents would stretch off-screen.  It will return to  the original positon if toggled 
back to Linear View mode. 

• The Clone Panel option from the Gear menu on the individual panels has been removed. 
 

Server 
• A new menu item under Maintenance allows you to immediately upload all Overlay Images for 

use on the V-Streamer(s).  Under normal circumstances this is not necessary since any overlay 
image selected in the User Interface will be uploaded automatically.  This feature is for test and 
future purposes only. 
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VestraView Client/Server | Version 2.0.32 
 

Note: This release includes major changes to publishing images to the web. If your 
system is currently publishing images to the web, Videstra will need to help you 
rework how it is being done to accommodate the new capabilities and features 
this release provides.  This new release is NOT COMPATIBLE with any previous 
publishing methods! 

 

Client 
• The TimeStamp Factory™ has been replaced by the Graphics Template Factory™ 

Creator/Manager.  You may now create multiple graphics overlay templates that include the 
ability to add timestamps to web published images as well as logos.  You may define multiple 
templates. 

 
New Graphics Template Factory Creator/Manager  

• The Graphics Template Editor now lets you add timestamps and an overlay image (Logo) and 
save the settings as a template.  Templates can then be used in the Primary and Secondary 
scripts for web publishing as well as in the Sequence creator. 
 

 
New Graphics Template Factory 

• You may now create multiple scripts for publishing to the web. This was done to accommodate 
publishing images from your cameras to two different web sites.  Each script can specify 

http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
http://whatislove-2010.blogspot.com/2012/02/dont-ignore-warning-signs-of-child.html
https://creativecommons.org/licenses/by/3.0/
https://creativecommons.org/licenses/by/3.0/
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individual elements including Graphics Template, Image Size, FTP Location, Update Interval and 
a name for the image as it needs to appear on the website. 

• Thumbnails can now be created automatically.  You may specify the size of the thumbnails. 
Thumbnails are always “clean” images (no graphic overlays or timestamps). 

Note: Thumbnails and the ability to size images appropriately are features created to assist 
website managers to reduce page-load times that will benefit by not sending images 
that are larger than they need to be (and further scaling them as thumbnails). 

 

 
New Script and Sequence Setup Tabs in Videstra 

 

• Image metadata that includes geolocation (Latitude & Longitude) as well as copyright and 
comment can be embedded in all web published images (except thumbnails).  An easy by 
address search mechanism is provided to discover the geolocation of any camera. 

• The new DOT Panel will now grab images directly from the streams provided by the DOT (rtsp, 
hls or rtmp only). 

• System is now compatible with Iowa and Arizona DOT feeds. 

• Fixed an issue with some cameras that create non-standard JPG files that was causing problems 
with adding overlays for Web Publishing. 

• Added a new STOPALL that automatically is issued (3 times) when using PTZ with any Axis 
camera. This will reduce, or eliminate, runaway panning on cameras that have poor internet 
connections. 

• Added a semi-hidden feature to widen the deadzone on the Axis T8311 Joystick. This may be 
necessary when the joystick ages and the center position causes drifting of the camera.  Please 
contact Videstra Customer Support for information if you believe you require this. 

• A new feature that allows you to create a panel that has no V-Streamer buttons has been added. 
This is handy if you have access to a camera from which you cannot get video, but still wish to 
publish images or create time lapse video.   Access this new setting in the camera settings dialog 
on the first (Basic Settings) tab. 

 

Server 
• Scripts will now timeout at the prescribed time (See Web Publishing → Scripts Interface).  Each 

script (Primary and Secondary) has a unique timeout, as does the Sequence-Timelapse feature.  
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Previously only the parent process was killed upon timeout, now the parent and all child-
processes are killed once the specified timeout is reached.  This will reduce or eliminate stray 
background processes that can use up V-Manager memory. 
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VestraView Client/Server | Version 2.0.29 

Client 

• You can now archive individual panels.  From the Gear menu on any panel you can now select 
Archive Panel.   

 
This will save a copy of the singular panel into the C:\Videstra\VestraView\PanelLibrary folder 
on the V-Manager.   
This is very handy if you wish to temporarily (or seasonally) remove panels from the application 
entirely but have an easy way to restore them without having to recreate them from scratch. 
You can restore any panel that was previously archived by going to the  
Configuration → Select From Archive Library menu.   

 
You will be presented with a list of all archived panels and you may place any back into the 
application (provided there are enough licenses to do so for the panel type. 
Any archived panel restored through this method will initially come up as Disabled but can be 
enabled through the Setup Panel from the gear icon on the panel itself. 

• The Axis PTZ control now sends multiple PTZ STOP commands whenever you release the left 
mouse button when using the mouse to move the camera.  This is designed to reduce the 
occasions of runaway panning/tilting when the communications buffer to the camera causes 
lost packets. 

• There is a new catch-all error trap that should help when camera communications cause 
unknown errors on the client. 

 

Server 
• The TEST button when setting up the IP Address for the V-Streamer(s) now ignores the 

connected status of the V-Streamer communications handler.  This is because when first setting 
up the V-Streamer there is no initial connection. 
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VestraView Client/Server | Version 2.0.28 

 

Client 
• New Timelapse Factory Stabilization feature that can stabilize shaky timelapse video created 

from cameras affected by high winds. 

 
You can see a video about this exciting new feature here:  
http://www.videstra.com/movies/stabilize/TimelapseStabilizationPromo.mp4 

 

• You can now force an update of all images in the Panels using the View → Refresh Panels menu 
item. This tells the server to send new images to all panels and will update all running clients. 

 
Server 

• When a panel is taken offline the V-Manager panel will show the date/time the panel was taken 
offline. 

• Options for the number of retries and Remote HW Reboot have been removed from the V-
Manager settings. The number of retries is now permanently set to 2. This means that a panel 
will automatically be taken offline after two successive minutes that the source (camera) cannot 
be contacted.  Once offline a background process is created to monitor the source and will 
automatically put it back on-line once it can be reached successfully. The HW Reboot function is 

http://www.videstra.com/movies/stabilize/TimelapseStabilizationPromo.mp4
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still available – but only when the Ambry IP-P2 is installed at the remote location and it is set up 
in the panel settings. 

• Images captured directly from the HLS, RTMP or RTSP streams of H.265 Sources now are more 
reliable. 

 

• The average time taken to grab an image from each source is now displayed on the V-Manger 
panel for each source.  
 

 
 
The time is shown in 1/10 second increments. Normal times should range from .5 to 7 seconds. 
Times longer then that may suggest poor or unreliable internet connections. 

 
 

 
 

   



 
 

43 | P a g e  
 

VestraView Client/Server | Version 2.0.24 

 

Client 
• Added an all-new DOT Panel that includes a Traffic Camera Selector for state traffic cameras. 

This lets a user pick from a list, or map of cameras based on data available from your state DOT. 
 

 
 
 Note: Minimum resolution required for the Traffic Camera Selector is 1024x768. 
 
The Traffic Camera Selector supports the ability to mark favorites that automatically stick to the top of 
the list (since there can be hundreds of cameras), the ability to search for cameras by name, region or 
route and the ability to preview still images and live video from each camera. 
 

• VestraView supports multiple DOT panels so you can assign several cameras for quick and easy 
access.  Each panel lets you assign a camera to any of your V-Streamer outputs. 
 

 
 

• Note: Each State manages their traffic cameras uniquely. Some states are easy and some are 
much more complicated.  Videstra will provide documentation and advice on the data and links 
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required by the new DOT Selector.  We’ve tried to make this functionality as flexible as possible 
but there is no guarantee that your state DOT can be supported.   

• The list of traffic cameras includes the camera name (usually a locational description), the DOT 
ID (supports multi-state DOT cameras) the region (usually the major city) and the route (typically 
the major roadway on which the camera is located). 

• The list can be sorted by Name, Region or Route for quick and easy access. 

• Pushpins on the map are each given the route number (if available) 
 

• You can preset the state for the DOT panel in the V-Manager under File→Settings→Traffic 

 
• The Client resolution now allows expansion to the full height and width of the primary monitor 

regardless of orientation (supports both vertical and horizontal orientation).  This allows for use 
of very high-resolution monitors to display many panels. 

• In TouchScreen mode the panel size would sometimes revert to non-touchscreen mode. This 
has been fixed. 

• In TouchScreen mode the panels now take the default Windows long-touch as a right click and 
starts the PTZ camera control for panels that offer PTZ.  For DOT or Flex Panels it will start a live 
preview function. 

• If a camera/sourcename is too long to display a new tooltip is automatically created so you can 
read the entire name by floating the mouse cursor over the name. 

 
 

• Flex Panel setup has been expanded for even more flexible options 

• Double clicking on a Flex Panel thumbnail (or selecting Preview from the “hamburger” menu) 
can now automatically launch VLC (if it is installed on the workstation) or FFPlay to view the live 
stream.  This can be set up under Flex Web Control in the Flex panel setup. 

• Enabling Drag & Drop from the Configuration menu normally times out after 30 seconds. This is 
done to reduce the chance of accidentally moving a panel.  
The Client Setup now offers the ability to set the timeout 
to various times as well as to “Permanent” so that D & D 
will never timeout. 
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• For the DOT Panel the preview function will always be available by double-clicking on the 
thumbnail or using the “hamburger” menu to select Preview.  No setup is required. 

 
• In the Clip Factory, if there are missing images, we now display a Question Mark image.  

 
This does not affect the video captured at the camera but is necessary to determine and 
calculate the range of video selected for download. 

• Some general cleanup in the Clip Factory™ to make the program a little more user-friendly and 
provide more accurate downloads of clips. 

• Note: You should make sure that the V-Manager AND all Axis cameras with edge recording 
capability (for the Clip Factory) are set to the same NTP Time Server – otherwise the V-Manager 
will have to make a “best effort” clock adjustment to account for any difference.  An error 
message will be generated if the clocks are more than 2 minutes apart. 

• The transparency setting in the TimeStamp Factory ™ was not being set properly when editing a 
previously set up TimeStamp.  This has been fixed. 

• When setting up a VestraView client and setting the IP Address of the V-Manager the “Test” 
button now does a much better test for the presence of a Videstra V-Manger at the selected IP 
Address. 

• There is a new “Refresh Thumbnails” menu item on the client under View.   This will tell the 
server to update all thumbnails on all connected clients. 

• In the Axis PTZ control exposure waveform can be toggled between live and off. Exposure 
calculations have been moved to a background, low resource, process. 

• In the Axis PTZ the Compass arrow now works with both the mouse and the Axis T8311 Joystick. 

• Some Axis PTZ settings are now changeable via registry edits on the client (only affects the client 
on the machine with the edits). The location in the registry is: 
HKEY_CURRENT_USER\Software\Videstra\VestraView\PTZTuning. These include: 

o  ExposureCheck (Default is 500 Milliseconds) is how often to update the exposure 
waveform 

o InvertJoystickTilt (Default is True) means pushing the joystick forward will tilt the 
camera UP 

o PTZJoyInterval (Default is 90 Milliseconds) is how often the joystick polls the camera for 
status 
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o Waveform (Default is False) means the Exposure waveform is off 

• Using the Fixed Image option in the Flex panel now works 

• The settings in the Flex Panel for Image URL, CGI and Fixed Image now must include the full URL 
and path information 

Note: You may need to update existing Flex Panel settings if using Image 
URL, CGI or Fixed Images 

• The VestraView Client now only supports Windows 7 (SP1) and Windows 10 

• Sony COM controls updated to the latest version 

• The Channel Manager now moves more swiftly 

• Channel Manager buttons now reflect locked panels properly 
 

 
 

Server 
• Rewrote the SourceMonitor for monitoring cameras (sources) that are offline. This significantly 

reduces the load on the CPU for disconnected sources and speeds recovery when a source does 
come back on-line.  SourceMonitor now uses only two command-line parameters (GUID and 
DOS-Friendly Source Name) from the V-Manager (not user accessible) for simplicity and 
flexibility. 

• VxFTP (a utility program for secure FTP transfers with the Videstra Web Publishing capability) 
now corrects a small error in Private Key Files (PPK) when Unix line-endings are used. This may 
happen if the PPK file is created on a Unix system. 

• Expanded the types of sources the SourceMonitor will now monitor. It now includes HLS and 
RTMP sources. 

• Thumbnails can now be generated directly from RTSP, HLS and RTMP streams if there is no still-
image method for a given source.  SRT streams cannot be used for capturing still images. 

• The Flex Panel has been expanded to work with HLS, RTMP, SRT stream types. 

• Last Error on each V-Manager panel now shows more information and has a tooltip available for 
long error. Simply float the mouse cursor over the text to see all of it. 

• Better, more accurate logging for when the V-Manager application ends.  It will now log whether 
it ended by a user action, a system reboot/restart or if it was stopped through the Windows 
Task Manager. 

• You can no longer stop the V-Manager application using the X in the upper right-hand corner of 
the application. You must now use the File→ exit menu. 

• The “Latest” image folder on the V-Manager now has a new subfolder called “Clean” where 
clean copies of the images are moved when the Web Publisher updates an image with either a 
timestamp or station logo. 

• Log files now save a trail of 10 files 

• A SourceMonitor Bug (a background process that monitors OFFLINE 
cameras/sources) will now properly log on to new versions of Axis camera 
firmware 

• The system will now always save a “Latest” image from all source panels, even if timelapse is not 
enabled for a panel.  Latest and timelapse are not available for Flex Panels using a fixed image 
(since it never changes) 

• There is a new System Geolocation in File→Settings→GeoLocation 
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Setting this (by using the lookup by city, state) 
will allow the Timelapse to know the sunrise and 
sunset times for certain calculations. 
 
 
 
 
 
 
 
 

 

• Background FFMPEG instances are now eliminated on server startup and are 
more aggressively removed during normal operation. (FFMPEG is used to grab 
images from RTSP, RTMP and HLS streams when there is no separate method 
for getting images) 

• Offline panels will no longer show “ERROR” when new clients log on 
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VestraView Client/Server | Version 2.0.16 

 

Client 
• Many fixes to the Videstra Clip Factory.  If the clocks between the V-Manager and the Camera 

were off by more than 2 minutes the application would crash. 

• More care taken to maintain proper time between the V-Manager Server and the VestraView 
Clients. 

• When entering the Clip Factory™ there is a new window showing progress since it can take time 
to get the list of available recordings from the camera(s). 

• If a timelapse image (called “index image” in the Clip Factory) is missing a generic image with a 
question mark it put into its place on the Clip Factory timeline.  This does not adversely affect 
the functionality but keeps timing accurate when selecting clips to download. 

• The starting point of any clips from the camera are adjusted to match the earliest available 
index image on the V-Manager. 

• If the camera is not currently recording the user will still be able to access any recordings that 
fall within the range of index images. 
 

Server 
• Added an internal function to the V-Manager to determine what NTP Server for time-

synchronization is being used.  If Axis cameras being used with the Clip Factory™ are found to be 
significantly out of sync with the V-Manager the user will be prompted to set the camera to the 
same NTP Server being used by the V-Manager (time.windows.com is the default). 
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VestraView Client/Server | Version 2.0.15 
Note: This is a minor update following the release of 2.0.14 which was not widely distributed… 

Client 
• Flex Panels that were set up to use no credentials would not automatically recover if a source 

went offline temporarily. The automatic recovery mode for Flex Panels without credentials now 
works properly. 

• A new folder is now created in the Latest folder called “Clean”  A non-modified version of the 
latest image for each panel will always be placed into this folder.  This was done to ensure a 
clean copy is always available if the system is setup to add either an overlay (logo) or a 
timestamp to the latest image in the Web Publishing options.  This feature can be turned on or 
off (on by default) in the V-Manager settings (File → Settings → General Settings tab). 

• The date of the timestamp was not properly updated if timestamps were turned on but 
sequences was not 

• Better handling of failed image downloads from cameras 

• Saying NO when the option to save Web Publishing options saved the results anyway. This has 
been fixed. 
 

Server 
• New option to turn on or off the saving of Clean images in the File → Settings → General 

Settings tab.  It is on by default. 

• If the location of the Sequence folder was changed in File → Settings → Paths it was actually 
changing the wrong setting. This has been fixed. 
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VestraView Client/Server | Version 2.0.14 
Note: This is a minor update following the release of 2.0.13 which was not widely distributed… 

Client 
• Applying overlays is now reflected in the thumbnail view much more quickly (previously it could 

take up to 1-minute to show up) 

• Setting the transparency in the Timestamp Factory™ to 0 would cause the Timestamp Factory to 
exit without warning 
 

Server 
• Internal changes to better support thumbnails – though not visible to the user this change 

makes the system much more responsive when image changes are required 
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VestraView Client/Server | Version 2.0.13 

Client 
• Videstra introduces the all new Timestamp Factory™. This is an all new tool that makes it easy 

and fast to create a top-of-image or bottom-of-image timestamp for web publishing.   

 
The Timestamp Factory lets you design a text field (any font, any color, any size) with or without 
a colored backplate (opaque or semi-transparent).  This can be sized and placed at the top or 
bottom of images you publish to the web. 

• Videstra introduces the ability to automatically create/maintain Image Sequences for Web 
Publishing. 

 
 
 
 
Sequences can be used to build timelapse animations as 
animated GIF files, MP4 movies or JPG flip-books for 
presentation directly on a web site. 
This powerful feature lets you update your web 
presentation as often as every minute and allows you to 
present a timelapse covering the last 30 minutes … or 
more! 
 
 
 

With the new sequence creator, you have full control over the interval between frames as well 
as the number of frames maintained. 
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• To support the uploading of sequence images a new command-line variable has been added to 
the script-runner engine that will pass the location of all image sequences for any given image to 
the script file as %6. 

• Adding timestamp to sequence images is optional. 

• VestraView and the V-Streamer are now SRT Ready! 
 
In conjunction with CamStreamer s.r.o you can now enable SRT (Secure 
Reliable Transport) on many Axis cameras.  This provides a reliable video 
stream over less-than-optimal network connections or when bandwidth is 
limited. 
Videstra is a member of the SRT Alliance. 
 

• With an 8-Channel configuration the application now properly sizes the TouchScreen mode 
when there are more than 4 buttons (up to 8 buttons are available with 2 V-Streamers™). 

• With an 8 Channel configuration renaming the last 4 buttons no longer requires a server-side 
restart. 

• Internal resource handling has been adjusted to reduce resource consumption. 

• Temporary Web Publishing script files are normally created; however, they were often left 
undeleted.  This has been fixed. 

• Scripting variables for date and time have been added ((date) will become the current, culture 
specific date and time will become the current time with meridiem (AM/PM). 

• A new HTTP Scheduler application is available upon request for customers who wish to send 
specific commands to their cameras at specific times. This application is in limited release for 
the time being.  Uses for this include: 

o Stopping a guard tour on a camera for a specified timeframe 
o Turning auto-exposure on at sunrise and off at sunset 
o Turning any camera feature on/off at specific times 
o Cameras must support http commands for such changes 

• The VxFTP Application (for uploading images to an FTP Site via FTP, FTPS or SFTP) now allows 
you to test even when uploads are sent as temporary filenames 

• Compass calibration for Axis cameras now works properly (always returned an error before) 

• Clip Factory now supports accessing multiple recordings on Axis cameras 

• EXIF information is faster but now only supports images from the Latest folder 

• Axis camera with the CamStreamer™ App installed will now connect via SRT. 

• HLS has been added to camera connections protocols, but is not yet fully supported 

• All passwords in the Camera setup pages now have an option to reveal 

• Self-Updater no longer adds V-Manager machine name to the sharename twice 

• Pinging the V-Streamer for connection status now is done on a separate thread for improved 
performance 

• The Flex Panel™ in VestraView now supports capturing images via a CGI call. Many 
cameras/encoders offer the ability to capture images via a CGI call.  Videstra is happy to help 
you determine if this is appropriate or possible.  A helper function has been added for Teradek 
CUBE encoders that support a CGI call for images. 
 

Server 
• When minimizing the V-Manager application it now animates to and from the system tray faster 

and cleaner 

https://www.srtalliance.org/members/
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• When viewing clients that are logged-on, the client version is now displayed 

• The message sent to clients when being forced off may now be longer (150 characters) 

• The server log now logs all client logons (with version) 

• Enhancements to the auto-installer. It will now prompt you for Administrative credentials when 
installing a new client 

• When the V-Manager application is closed the log is updated to indicate if a user closed the 
application or if a system error/system reboot closed the application 

• Checks for the presence of a running V-Streamer are now independent of the UI Message pump. 
This results in no interruption of the UI during this brief process that occurs every 10 seconds 
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VestraView Client/Server | Version 2.0.11 

Client 
• Clip Factory now fully supports Axis Q6125-LE 

• Major update to client auto-updater. These changes will only affect updates after this release 
o Security model has been updated to allow installations when a client is running under a 

non-admin account (user will be prompted for admin password if an update is 
presented) 

o Added command-line switch to client (/forceinstall) to force an installation no-
matter what version is in the V-Manager c:\Videstra\VestraView\ClientInstaller 
folder 

o Checking for client updates always timed out due to error in synchronous network call 
o Added additional logging to the update process 
o Added additional prompting to the update process 

• Added Videstra HEVC/h.264 VS100P/S method to image capture helper in Panel Setup 

• Compass Calibration in Axis PTZ control now works correctly 

• When rebooting the V-Streamer from the client and presented with a password dialog box, 
cancelling the dialog resulted in rebooting the V-Streamer anyway 

• Client now logs its version at startup 

• When using venue specific settings (hiding channel buttons on a client) hiding the first button 
caused the remaining buttons to align improperly 

• When there are no panels creating the first one would always fail 

• Channel Manager ALL button will no longer highlight all the buttons if ALL is cancelled 

Server 
• New multi-threading model stabilizes resource usage (Thread & Memory) 

o Added error checking to usage count during image updates (every minute) 

• New method for animating the V-Manager application to the system tray 

• Additional logging adds version to startup and the reason the server might have been stopped 

• V-Streamer statistics are now updated every 10 seconds 

• A connection list for Axis cameras can be accessed from the V-Manger panel Gear Icon 

 
• Minimizing the V-Manager application to the system tray now animates more visually 

• Client Version now reports in the View Connected Clients dialog on the V-Manager 

• When forcing a client off from the server the message to the client(s) can now be up to 130 
characters (previously was only 50) 

• When the V-Manager closes the Windows “Reason for Close” is now logged 
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VestraView Client/Server | Version 2.0.8 

Client 
• When adding new panels, you can no longer use a panel name that is already in use 

• When creating a new panel, you can now make the password visible 

• IP Addresses can no longer have leading 0’s (Zeros) (e.g. 145.027.035.247) 

• First time startup would often not size the application correctly 

• Added the ability to grow/shrink the VestraView client from both top and bottom (previously it 
was allowed only from the bottom) 

• The panel picture now shows up when opening a camera panel for the first time if a connection 
can be established 

• In addition to drag & drop of panels there is a new “Move To” menu item in the options 
(Hamburger) menu that allows you to quickly reposition any panel 

 
• PTZ option would occasionally disappear 

• When changing the name of a panel you are now warned that it must start collecting images for 
Time Lapse all over again 

• When the system is in Multiselect mode (allowing you to put a camera/source on more than one 
V-Streamer channel) you may now select NOT to put an overlay on any of the channels. A 
checkbox will appear below the buttons to prevent the overlay from appearing on any channel 
from which you Uncheck. This allows you to have an overlay on some channels, but not on 
others 

 
• A new debug menu item is available from the Help menu. This is for diagnostic purposes only 

• Clients now make more of an effort to determine the status of a V-Streamer connection to a 
camera 

• Enabling Drag & Drop (under the Configuration menu) will time out in 30 seconds if it is not 
used. Any Drag & Drop action will reset the timer 

• Cloning a panel from the setup menu on the panel (Gear Icon) now copies all the information 
from the current panel into the new clone – except the name. You cannot use the same name 
twice.  Creating a new panel with Configuration → Add New Panel does not copy any 
information from any of the existing panel – you are starting fresh.  Cloning a panel is used only 
for creating an exact copy of an existing panel – except for the name.  You may make changes to 
the cloned panel without affecting the source of the cloned panel 
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• For better readability, the overlay list in the drop-down now shows the original case of the 
overlay graphic.  

 
 
Note: All graphic files continue to be uploaded to the V-Streamer converted to lower case 
 

 

Server 
• Many major performance improvements designed for Web Publishing by reducing the thread 

priorities for background programs 

• Images older than 3 days (or 4 days if the system was set for that) were not being deleted 
resulting in the V-Manager hard drive eventually filling up 

• Proxy did not show the IP Address on the panels 

• Panels are now updating more efficiently 

• Sony camera access from V-Manager now defaults to only the IP Address of the camera since 
new models no longer use the old URL path of en/index.html 

• V-Manager panels would often show “Playing” when a camera was not connected to a V-
Streamer 

• Overlay Manager has been removed. Overlays are now added by simply placing them into the 
c:\Videstra\VestraView\SDIOverlays folder on the V-Manager.  The V-Manager will 
automatically put them onto the V-Streamer(s) and remove them when necessary.  You can 
quickly access the SDIOverlays folder from the Maintenance → Go To SDI Overlays Folder 
 

 
 

• The V-Streamer now supports new API Calls for efficiency and older versions of the V-Streamer 
will not be compatible with V2.0.8 of VestraView Client and V-Manager 

• Network transmissions are now compressed for efficiency 
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VestraView Client/Server | Version 2.0.3 (v203) 

Client 
• Updated Sony Camera PTZ to allow for use of the Axis T8311 Joystick (automatically enabled if 

plugged into the computer running the VestraView client) 

 

Server 
• New faster and more efficient method for updating images from sources (Cameras) 

• Fixed a bug with Sony cameras that would always call Image2 for the V-Streamer even when 
Image1 was selected 
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VestraView Client/Server | Version 2.0.1 (v201) 
 

Note: This is a major update to the entire VestraView by Videstra system and 
requires an update of the V-Streamer to Version 2.0.1 as well (Version numbers 
between the Videstra VestraView client/Server and the V-Streamer to not have to 
match – it just worked out that way this time…) 

 

Client 
• Client/Server now fully supports 8-Channels (two V-Streamers are used for 8-channels) 

• Client supports different venue settings so that buttons can be hidden and inaccessible on 
clients in specific venues. (MENU: Configuration → Client Settings) 

 
Access to this dialog may be password protected by the system manager. 

• System supports overlays on the SDI Outputs of the V-Streamer. Each channel can support 
separate overlays. Overlays can be selected on the panel for each available source. 

 

 
 

To select an overlay, click on the OVL button at the bottom of the image – and select one of the 
overlays or “none.”  The overlay button (OVL) can be enabled and disabled on each individual 
channel or can be disabled globally for any installed client. Overlays will appear on the SDI 
output and on the Panel Image after selected. 
Permanent overlays may also be set for any panel – in which case no-one can select an 
alternate overlay. 

• All new Clip Factory™ for accessing and downloading live recorded video from Axis Cameras 
supporting edge recording (Test on Q61 series only).  
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The Clip factory works much like the TimeLapse Factory™ but the individual images serve as an 
index into the recorded video. Several minutes of recorded video from any available time-period 
can be downloaded, converted and sent to an editor or playout device. 

• Super-Timelapse is available as part of Clip Factory.  This allows you to download longer clips 
and render them into a final movie format at timelapse speeds from 1x to 100x. 

 
Rendered movies can be saved to any location available to the user (local, network or Weather 
Graphic system). 

• Beginning with the next release (After this version) VestraView clients will automatically indicate 
if an update is available.  Updates may be optional or mandatory. If mandatory the client will 
not let you start until it has been updated (which can take a minute). 

• Added a new Videstra CloudShare™ information icon to CloudShare panels.  This appears as a 
small i-icon on the CloudShare panel. Users can click on the icon to get information on the origin 
and location of the CloudShare camera(s). 
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An additional button on the Information panel allows the users to see the exact location of the 
camera on Google Maps. 

• The color of the source panels has now changed from a yellowish to blueish. 

• Manual camera reboot has been added to the gear icon   instead of the hamburger icon  

• When adding panels a new TEST functionality for the new panel has been added to better 
determine if the connection is good.  The same Test has been added to the panel setup for Axis, 
Sony, Truen and Flexpanels. 

 
 

• Axis Stream Settings now allows you to set the connection to the camera for PTZ to use RTSP or 
RTSP over HTTP (axrtsp) in case there are direct firewall issues. 

• All cameras/panels allow you to hide the compass or presets if desired. 

• Channel Manager has a simpler look & feel. 

• Many other major and minor bug fixes 
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Server 
• A special background process called SourceMonitor keeps track of offline sources. This process 

now automatically exits if the VManager application is closed. 

• We have removed the option to have cameras automatically reboot when there is an error. 

• Removed the ability to let VManager select between UDP or TCP on connections. One of the 
two must now be explicitly selected. 

• System can be set up to allow a single source to be assigned to more than one V-Streamer 
channel.  By default the system will only let you assign a source to one V-Streamer channel. If it 
is already assigned to a V-Streamer output it will be removed before it is assigned to the new 
channel unless “Allow MultiSelection on V-Streamer is checked in the V-Manager Settings → 
General Settings tab. 

• When web scripts are defined and scheduled to run it is now possible to temporarily turn them 
all off under File → V-Manager Settings → Web Scripts 

• You may now select to have web scripts run every minute or less often. (1, 2, 3, 4, 5, 10, 20, 30 
minute intervals are selectable) 

• On the VManager to can set it so all PTZ Dialogs timeout, timeout and disappear, or never 
timeout.  You can also select the amount of time you want the PTZ dialogs to timeout. 

• An overlay manager has been added to make overlay images available for use. All overlays must 
be uploaded to the V-Streamer(s) (Both V-Streamers if you have an 8-channel system). 

 
Note: This has been removed in newer versions – see notes for 2.0.7 

• Many other major and minor bug fixes  
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V-Streamer Release Notes 
V-Streamer (V4.0.10) 

• Update to YT-DLP Libraries for changes in YouTube stream acquisition. 

• The V-Streamer now has a new setting to increase the TCP/IP Buffer for HLS and RTSP streams. 
The default is 20 Mb, but it can be either increased or reduced. 
Note: Increasing the buffer may improve stream reliability for problematic streams but will 
increase latency.  Decreasing the buffer reduces latency but can reduce reliability on problematic 
streams. 

• The AJA Drivers for the AJA Corvid I/O card (used for HDSDI output and genlock input) have 
been updated to version 16 from version 14. 

 

V-Streamer (V4.0.7) 
• The V-Streamer is now compatible with YouTube™ Live Streams 

 

V-Streamer (V4.0.6) 
• New logos and name treatment only to conform with updated branding. 

 

V-Streamer (V4.0.5) 
• A new element has been added to the V-Streamer REST protocol that allows assigning a GUID to 

each channel.  This is not exposed to the users. 
 

V-Streamer (V4.0.4) 
• SRT (Secure Reliable Transport by Haivision™) now properly accepts DNS names as well as IPV4 

and IPV6 addresses for the URL. 
Note: Videstra is a member of the SRT Alliance, and the V-Streamer is SRT Ready 

 

 

V-Streamer (V4.0.3) 
• Better Support for some still images that are presented as a binary stream via HTTP rather than 

as a direct JPG or PNG download. 

• The Schedule tab now supports multiple service restart times. This is not a reboot, but only a 
service restart that takes a few seconds.  It is recommended to do at least one per day, but two 
(or more) may be scheduled if some older camera connections with problematic RTSP servers 
cause issues for the V-Streamer. 

• Additional memory leak improvements 
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V-Streamer (V4.0.2) 
V-Streamer Version 4.0.2 includes several enhancements and decoding capabilities. 

• Ability to connect to an http link to a still image (jpg or png) and treat it as live video. This makes 
it possible to show some DOT traffic cameras that only offer still images. By default it will update 
every 30 seconds. 

• New At-A-Glance channel status shows all four channel status’s at the top of the Channels tab. 
 

 
 

Each of the 4 individual channel status dots will be either green or red. Green indicates the 
channel is playing while red indicates an error on the channel.  Dots represent the 4 channels 
1,2,3,4 from left to right.  The status is also echoed on each channel panel. 

• Soft Reset option is now available on the Restart / Shutdown tab. This simply restarts the 
firmware without rebooting the entire machine. Typically takes less than 15 seconds while a full 
reboot can take up to one minute. 

• New Tag property for each channel – used by the V-Manager for source confirmation 

• New diagnostics page designed to help Videstra see and diagnose decoding or other issues. By 
default this page is not accessible, but can be turned on at the bottom of the System tab. 
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• When Diagnostics are enabled a new Diagnostics tab will appear on the V-Streamer Web Control 
allowing you to grant temporary access to the V-Streamer SSH Console by Videstra.  This is a 
completely secure tool that does not require opening any network ports by your IT division.  You 
may be requested to enable this feature if the need arises. 
 

 
 

• The V-Streamer Discovery tool (IP Utility) now supports an unlimited number of V-Streamers 
and shows more information about each V-Streamer including the default gateway, serial 
number, and firmware version. 
 

• The V-Streamer Discovery tool (IP Utility) now allows for a right-click to open the web page, or 
an SSH session, see the status page, reset, reboot (along with other options). 
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• The console menu now shows information about the system above the menu 

 
• It is now possible to incorporate the V-Streamer into Ross Dashboard™ - a how-to video is 

available at: https://www.videstra.com/movies/RossDashboard.mp4 

• Basic Web Authorization security has now been enabled for CGI scripts on the V-Streamer. CGI 
scripts are used for resetting, rebooting and various maintenance and settings tools. 
 
 

  

https://www.videstra.com/movies/RossDashboard.mp4
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V-Streamer (V4.0.0) 
V-Streamer Version 4 represents many new features and capabilities.  Version 4 introduces VestraView 
Essentials™ – which is licensed separately.  VestraView Essentials is a stand-alone capability for the V-
Streamer to self-manage a small number of cameras/streaming sources without the need for a V-
Manager. VestraView Essentials runs entirely on the V-Streamer and supports 

• A completely Web Based User Interface 

• Managing up to 6 cameras or streaming sources as individual “Panels” 

• Moving Panels 

• The ability to freely assign sources to any of the V-Streamers 4 HDSDI outputs 

• Overlays and Cropping 

• Direct one-button access to a camera’s web control page 

• multiple NICs 

• Save and restore Essentials configuration 
‘Essentials’ licensing is only available as a separately licensed product. 
 
Other V-Streamer 4.0 Features/Bug Fixes 

• Ability to connect to an http still image url (such as a direct link to either a jpg or png image) and 
output an HDSDI still image.  This is intended for use with DOT Traffic systems that only make 
still images of various cameras available.  Still images are automatically refreshed every 30 
seconds by default – but the refresh interval can be set from 0 to 60 seconds (0 = off) 

• A Soft Restart has been added to the Restart/Shutdown page.  This restarts the V-Streamer 
application on the unit but does not do a full reboot or restart. 

• Before a V-Streamer is licensed the HDSDI Video Channel 1 Output will display the IP Settings of 
the box. This is very handy when the box is set to DHCP and you want a quick way to discover 
the settings.   All channels can now be set manual to Black, Pattern, URL (for streaming video 
sources) or IP. 

• If a channel is set to display an overlay, subsequently setting it to Black or Test Pattern will 
automatically remove the overlay. 

• If an overlay image (PNG File) without an alpha channel was placed onto the system and used it 
would lock up the V-Streamer. Beginning with this release any PNG file without an alpha channel 
is ignored. 

• Other bug fixes and enhancements 
 
 

V-Streamer (V3.0.5) 
• Added support for 1080P 59.94 and 1080P 50 (3GA) 

 

V-Streamer (V3.0.4) 
• Updated Scheduler (Schedule tab) so that the application restart runs using the correct path to 

the service app on the V-Streamer 

• Minor memory leak fixes 
 

V-Streamer (V3.0.3) 
• Added SRT Decoding to the V-Streamer 

• Licensing would sometimes fail when the licenser would access certain hardware items in a 
different order 
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• You can no longer upload anything other than a PNG file for overlays 

• There is a new front-end menu on the V-Streamer Linux console 

 
This makes it easier for initial deployment 

• More than one DNS entry may now be entered on the network page by separating it with a 
single space 

• Overlays now support semi-transparency (still must be PNG files) 

• The V-Streamer now support aspect ratio settings of  
16x9 (default) | 14x9  | 4x3   | AutoZoom 

Where 14x9 produces very small black wings, 4x3 is pillarbox and autozoom is letterbox 
 

V-Streamer (V3.0.1) 
This is a major release requiring a special upgrade 
method. Videstra will ship a USB drive to you at no 
charge (provided you are under service contract) and 
supervise the update via telephone/internet.  A new 
License must be generated for your V-Streamer 
following this update. 

• The V-Streamer has been updated to Linux 18.04 and AJA Drivers 14x 

• V-Streamer now supports h.265 (HEVC) as well as legacy MPEG4 

• In addition to RTSP, new streaming protocols are now supported 
o RTMP 
o SDP 
o HLS (http) 
o SRT 
o UDP/TS 

• Multicast connections are now supported on secondary NIC 

• V-Streamer now supports live-cropping of sources using Videstra V-Scaling technology 

• V-Streamer audio is now fully synchronous  

• V-Streamer supports AAC and G.711 audio 

• An automated internal memory cleanup is run nightly. This is optional and can be controlled on 
the V-Streamer web page on a new Schedule tab (setting your time zone is also available on this 
tab) 

• Cleaner startup when connecting to all sources 

• New ‘Status’ tab on the V-Streamer Web Control page 

V301 now runs 
on Ubuntu 
18.04 LTS 
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• Overlays and test patterns are now scaled to the output raster 

• Initial connection following reboot now waits 2-seconds between each channel 

• On loss of stream (internet disconnect, etc) the V-Streamer will no longer flash between 
multiple frames in its buffer. 

 
V-Streamer (V2.0.1) 

• V-Streamer now supports assignment of the same panel on more than one output channel. 
Internally it will simply duplicate the frames to additional output channels rather than opening a 
separate stream for each channel from the same source 

• The V-Streamer now supports AlphaImages for overlays. AlphaImages must be .png files sized 
with the canvas to be the same as the chosen output resolution (e.g. 1280x720/1920x1080) with 
the appropriate overlay logo/text sized and positioned as desired. 

• The V-Streamer now supports more than one Network Interface card (all V-Streamers are 
shipped with two) 

• The V-Streamer Web Control Interface has been updated and now looks a little different.  

 
V-Streamer (V1.0.37) 

• V-Streamer will now more aggressively handle poor Internet connections 

• A new ‘rebooter’ user has been added to allow remote rebooting of the V-Streamer when 
conventional remote reboot is unavailable 
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Addendum – YouTube® Statement 
 
YouTube Statement from Videstra 

In Version 2.3.13 and above Videstra is providing the capability to utilize live 
streams from YouTube™ in the VestraView application.  We do this with the best 
intentions but cannot guarantee future compatibility with changes that may be 
made by the owners and operators of YouTube. While Videstra may try to address 
any issues that arise from changes that adversely affect use of this feature in the 
Videstra system – we may, at our own discretion, determine that the cost of 
addressing any issue is beyond our economic ability and therefore not provide 
any appropriate fix.  Furthermore, use of the Videstra YouTube capability comes 
at the sole risk of the end user.  
Regarding the use of copyrighted material on YouTube – The YouTube feature in 
Videstra does not, and cannot block, or even reliably warn against use of 
copyrighted material that is made available through a YouTube live stream.  Use 
of any copyrighted material with the Videstra YouTube interface is done so at the 
end users’ sole responsibility and risk.  It is strongly recommended that users seek 
appropriate permission to use any YouTube Live Stream whether it is believed to 
be under copyright protection or not. It is further recommended that you consult 
with your own legal experts on the matter if you believe the content to be 
available under the fair-use doctrine.  Under no circumstances will Videstra 
assume any liability that may arise from use of any material via the YouTube 
interface. 
If you wish to avoid potential legal issues regarding YouTube Live Streams by 
disallowing the YouTube interface in the Videstra system please contact Videstra 
and we will remove the feature from your system. 
 
 


